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Compliance

Federal Communication Commission Notice 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to

part 15 of the FCC Rules.  These limits are designed to provide reasonable protection against harmful

interference in a residential installation.  This equipment generates, uses and can radiate radio frequency

energy and, if not installed and used in accordance with the instructions, may cause harmful interference to

radio communications.  However, there is no guarantee that interference will not occur in a particular

installation.  If this equipment does cause harmful interference to radio or television reception, which can be

determined by turning the equipment off and on, the user is encouraged to try to correct the interference

by one or more of the following measures :

– Reorient or relocate the receiving  antenna.

– Increase the separation between the equipment and receiver.

– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

– Consult the dealer or an experienced radio/TV technician for help.

Use of shielded cable is required to comply with class B limits in Subpart B of Part 15 of FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the instructions.

If such changes or modifications should be made, you could be required to stop operation of the

equipment.

Model Number : MCD-100

Trade Name : EIKI

Responsible party : EIKI International Inc.

Address : 30251 Esperanza, Rancho Santa Margarita,CA 92688-2132

Telephone No. : (800)242-3454 (949-457-0200)

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.

Cet apparei numérique de la class B est conforme à la norme NMB-003 du Canada.

L’utilisation de ce dispositif est autorisée seulement aux conditions suivantes : (1) il ne doit pas produire de

brouillage et (2) l’utilisateur du dispositif doit être prêt à accepter tout brouillage radioélectrique reçu, même

si ce brouillage est susceptible de compromettre le fonctionnement du dispositif.

For French Users
Restricted frequency band only channels 10 through 11 (2457MHz and 2462MHz respectively) may be
used in France. License required for every installation, indoor and outdoor installations. 
Please contact ART for procedure to follow. Do not use this wireless LAN card in the open air.

CAUTION
Changes or modifications not expressly approved by the manufacturer could void the user’s authority to

operate the equipment.

Exposure to radio frequency
This product uses a wireless LAN card (CF Card) to communicate with other devices using the 2.4 GHz ISM

band. The radiated power output of this card is well below FCC radio frequency exposure limits. However,

it is advised to maintain a minimum 20 cm separation between the product and user(s) or bystanders to

minimize human exposure to the transmitted radio frequencies.
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Safety Instructions

All the safety and operating instructions should be read before the unit is operated

● Follow the instructions in the Owner’s Manual for the projector and other peripherals when
you install or operate this unit.

● Disconnect the power plug of projector and other connected devices from the AC outlet
when you install or remove this unit.
Attempting to install or remove the unit while the power is connected to the AC outlet may
cause electric shock and damages to the unit.

● Do not attempt to disassemble, modify, or repair the unit.
Failure to comply with this caution may cause fire or electric shock, and damages to the unit.

● Operating the unit when the unit is emitting excessive heat, fumes, or strange odor may
cause fire or electric shock.
Disconnect a power supply plug from the outlet.

● Do not drop the unit or subject it to other mechanical shocks.
The internal parts may become damaged and may cause electric shock, fire or cause the unit
to malfunction.

● Before operating this unit, make sure that no electromagnetic interference is produced.
Operation of any radio equipment may interfere the functionality of some medical devices
(such as pacemaker).

● Do not touch the unit with wet hands.
Doing so while the power supply plug of a projector or other devices are connected to the AC
outlet may cause electric shock.

● Do not operate cellular phones too close to this unit. (Within 20 cm).
Doing so may cause this unit to malfunction.

CAUTION IN USING THE PROJECTOR VIA NETWORK
● When you find a problem with the projector, remove the power cable immediately and

inspect the unit. Using the projector with failure may cause fire or other accidents. 
● If you remotely use the projector via network, carry out a safety check regularly and take

particular care to its environment. Incorrect installation may cause fire or other accidents.

CAUTION IN USING MULTI CARD DIRECTOR
● EIKI assumes no responsibility for the loss or damage of data, or damage of the computer

caused by using this projector. Making back-up copies of valuable data in your computer is
recommended.
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Introduction

This Owner's Manual will show you how to set up and operate Multi Card Director.
Before using, read this manual thoroughly and operate properly.

Package Contents

The package contains following items.  Check each item as you unpack the package.  If you
have any of the following items missing, contact the sales dealer.

• Multi Card Director
• CD-ROM
• Operation Manual (2 kinds)

Caution about Radio Wave
This unit operates in 2.4 GHz band, the same frequency band used for industrial, scientific, and
medical equipment (such as pacemaker), as well as amateur radio stations.

Please read “Safety Instructions” section and make sure the following cautions.
1. Be sure that there are no other devices in the area that may use the same frequency band as

Multi Card Director.
2. If any other devices are causing radio interferences, change the communication frequency

channel or move to other location.

Trademarks and Copyrightﾆ
Microsoft, Windows, Windows 95/98/Me, Windows NT 4.0/2000/XP and Internet Explorer are
registered trademarks and product names of Microsoft Corporation in the U.S.A. and other
countries.
Netscape Navigator and Netscape Communicator are registered trademarks or trademarks of
Netscape Communications Corporation in the U.S.A. and other countries.
Pentium is a registered trademark of Intel Corp. in the U.S.A.
Each name of corporations or products in Owner’s Manual is a trademark or a registered
trademark of its respective corporation.

Notes
● The contents of this manual are subject to change without notice.
● You may not copy the printed materials accompanying with the software.
● We shall not be responsible for any damages caused by reliance on this manual.

Introduction
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In this owner's manual, Multi card Director can be referred to as "MCI" or "Muti Card

Imager". These names can also appears on the operation screens and relevant

descriptions.
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1. Functions of  Multi Card Director

1

Functions of Multi Card Director are described in this
chapter.
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1. Functions of Multi Card Director

Multi Card Director ( hereinafter called " MCI " ) is a multi-interface device which allows
projectors to be used via a wide range of media. You can use it with one of the multi-cards as follows:

Via wireless LAN, computer screen image can be transmitted to the projectors which are
remotely located. A single computer can transmit images up to five projectors.  Besides this
function, it can control and operate the projectors.
This function allows you to give presentations at anywhere you wish without an onerous cable
connection.
Since the MCI can access to the wired LAN via an access point (infrastructure mode), no
additional line construction will be required.

* IEEE802.11b, standard TCP/IP communication protocol supported. 

MCI can be directly connected to LAN line using a LAN cable. As the wireless LAN connection,
it can transmit images to projectors and control or operate them via LAN connection. 

* 10BASE-T, standard TCP/IP communication protocol  supported.

Under Wired or Wireless LAN environment, you can project the image stored in the FTP server
on the network. 

Without using computers or video players, presentation data can be played only using a
projector. The supplied data converting software:Slide Converter will converts PowerPoint,
bitmap and JPEG data to the presentation data which can be played by the viewer function.
Besides, its unique editing functions allows you to create presentation data composed with
various types of images.
For details of the viewer function and slide converter, refer to the separate manual " Viewer /
Slide Converter".

Wireless LAN  (Wireless LAN card: CA-30*)

Wired LAN  (Wired LAN Card : CA-20*)

Network Viewer

Viewer ( Compact Flash Card :  CA-10*)

* Sold Separately
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Read this chapter first.
This chapter describes how to setup the Multi Card
Director. According to the using environment,
configure your Multi Card Director. 

2. Setup Procedure
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2. Setup Procedure

Depending on a purpose or environment of the usage, Setup procedure of the MCI will be
varied. Follow this flow diagram to properly setup your MCI. 

STEP 1 Check the contents in a package

To begin with, check the contents in a package and read carefully the safety
instructions.

STEP 2 Confirm part names and functions
Familiarize yourself with part names and functions of MCI.

☞ 4. Part Names and Functions,Factory Default Setting, Installation of MCI

Understand functions and operation of the MCI.
☞ 1. Functions of Multi Card Director

☞ 3. Operation of Multi Card Director

STEP 3 Attach the Multi Card Director to a projector

Attach the MCI to a projector and insert one of the optional multi cards to the MCI.
☞ 4. Part Names and Functions,Factory Default Setting, Installation of MCI
* Wired LAN connection................................Insert a wired LAN card(CA-20).

* Wireless LAN Connection ..........................Insert a wireless LAN card (CA-30).
* Use MCI as a viewer ..................................Insert a compact flash card (CA-10).

Refer to the separate manual, " How to use Viewer/ How
to use Slide Converter "

STEP 4 Install the software

Install the supplied software (MCI Client, Slide Converter) to your computer.
☞ 5. Software and Installation

STEP 5 Configure LAN 
Configure wired or wireless LAN connection.

Wireless LAN connection ☞ 7. Wireless LAN Configuration
Wired LAN connection ☞ 6. Wired LAN Configuration

Detailed configuration is available by using browser. 
☞ 8. Configuration with Browser

STEP 6 Setup Completed

Setup procedure is completed. Now you can operate projectors via wireless/wired LAN.

Display the images on the computer ☞ 9. Display Image via Network

Display the images in the FTP server ☞ 11. Network Viewer

Control or operate a projector ☞ 10. PJ Controller

☞ 8. Configuration with Browser
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3. Operation of Multi Card Director

・Operation of Multi Card Director

・LAN Connection
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3. Operation of Multi Card Director

Since Screen-capture System - the system transmitting images on the computer screen to
projectors - is adopted, MCI can be used at various occasions free from software restrictions.
Below is a diagram showing the system transferring an image from a computer to projectors.

1. Use the exclusive software - MCI client - to load the computer screen in real-time. 

2. The loaded image data will be compressed and transmitted to the MCI via wireless or wired
LAN.  A single computer can transmit the image to up to five projectors. 

3. MCI converts the transmitted image data into RGB digital signal and then output it to the DVI
input terminal of the projector. 

* Since the image is being transmitted one by one, time-lag of the image projection will be occurred.

CAUTION： THIS SYSTEM IS NOT APPLICABLE TO AN APPLICATION

SOFTWARE USING DIRECTX, MS-OFFICE ASSISTANT,

AND REPLAYING OF MOTION PICTURES, SUCH AS DVD.

MCI System Block Diagram (Sample)

※ Below is a sample of wireless LAN block diagram. Image data can be transmitted to
projectors from Computer 1 or Computer 2. 

0.0
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Computer 1

MCI

MCI Client
Computer 2

Operation of Multi Card Director
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Operation of Multi Card Director

LAN Connection

E
n

g
li
s
h

LAN Connection

■ Wireless LAN  Infrastructure Communication Mode
An access point will bridge or route your wireless LAN devices to a wired ethernet
network.  Wireless LAN devices can also communicate each other via the access point.
Wireless LAN device will specify an access point using SSID/ESSID, a communication
mode used in a network environment includes both wireless and wired LAN connection.

Access PointComputer 1 Wireless LAN compatible computer
Infrastructure Mode

MCI（Wireless LAN card）
Infrastructure Mode

■ Wireless LAN  ADHOC 802.11Communication Mode

A communication mode used between wireless LAN devices. The devices are communicated
by SSID/ESSID.

Wireless LAN compatible computer
AdHoc Mode

Computer

Computer 2

MCI（Wireless LAN card）
AdHoc Mode
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■ Wired LAN Communication Mode
The devices communicate via wired LAN line.

Computer 1 Computer 2 Computer 3

MCI（Wired LAN card）

✐ A remote control unit supplied with a projector can operate computer mouse ✐

If your projector is supplied with a remote control unit with a mouse-driven function,
you can operate the computer mouse with this remote control unit. Aim the remote
control unit towards the projector. 
The projector does not need to be connected by a USB cable. (For further detail of the
remote control operation, refer to the owner's manual of the projector. )

3. Operation of Multi Card Director
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4. Part Names and Functions

Factory Default Setting

Installation of MCI

4

Read this chapter carefully to handle and install the
MCI properly.
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4. Part Names and Functions, Factory Default Setting, Installation of MCI

q POWER Indicator（Green）
Normal : Lighted
Error : N/A

w STATUS Indicator（Yellow）
Normal   : Blinks when receiving packets
(Only when own node receives the packets)

Error : N/A

e ERROR Indicator（Red）
Normal : Off
Error : Lighted

r Eject Button
Push this button to eject a multi card.

Multi Card: Wireless LAN Card /

Wired LAN Card/ Compact Flash card. 

t Multi Card Slot
Multi card insertion slot. 

y Latch Button
Used when mounting and removing the unit
from the projector.

u Mounting Screw
Used when mounting  the unit to the projector.

i Connector Plug
Plugs MCI into the DVI connector of the
projector.

o Switch Button
Lets the projector detect the MCI is
attached.

!0 Mounting Hooks
Used to attach MCI to the projector.

!1 Test Switch
Used to check the current LAN setting or
return MCI to the Factory default Setting.
For detail, refer to the next page.

Front

Rear

q w e

r

t

y

u

i

o

!0

!1

Part Names and Functions
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Part  Names and functions

Factory Default Setting

MULTI CARD DIRECTOR INFORMATION:
MAIN PROGRAM:        VX.XX(XXXX/XX/XX) 
BOOT PROGRAM:        VX.XX(XXXX/XX/XX)
CARD TYPE:           FCC/IC(US)
MAC ADDRESS:         00C06FXXXXXX
CONFIGURATION #:     LAN3
IP ADDRESS:          192.168.100.100
SUBNET MASK:         255.255.255.0
GATEWAY ADDRESS:     255.255.255.255
IP CONFIGURATION:    MANUAL
ARP + PING:          ENABLE

*WIRELESS MODE:       802.11 ADHOC
*WIRELESS CHANNEL:    11
*WIRELESS SSID/ESSID: WIRELESS
*WIRELESS WEP:        DISABLE

Factory Default Setting

MCI has 3 settings (LAN1,2 and 3) for Wireless LAN and another 3 settings (LAN4, 5 and 6) for
Wired LAN. Select the setting to suit your LAN environment. 
LAN settings are provided at the factory. Select the LAN setting close to your using
environment and adjust the values. LAN 3 for wireless LAN, LAN4 for wired LAN are preset at

the factory.（Refer to " Contents of Factory Default Setting" on next page）

Check Factory Default Setting
To check the current LAN setting, follow the steps
below : 
1) Turn on the projector and select "Wireless" or

"Wired" for its input. 
2) Press the Test Switch with a sharpened tool.
3) The current LAN setting is displayed on the

screen for 10 seconds. 

Reset the Setting to Factory Default Setting
To reset the MCI to the factory default setting, follow the steps below :
1) Turn on the projector and select "Wireless" or "Wired" for its input. 
2) Press and hold the Test Switch for approx.10 seconds. After all the indicators on the MCI are

flashing simultaneously, the setting will be then reset to the factory default setting.
MCI cannot be reset when no LAN card or compact flash card is attached.

Example : Projection Contents of Factory Default Setting (Wireless LAN Card inserted )
* WIRELESS SSID/ESSID is set in lower-case character, it is shown only in upper-case 

character.
* It may be different from the actual screen. 

* Only for wireless LAN

Test Switch
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4. Part Names and Functions, Factory Default Setting, Installation of MCI

項目 Factory Default Setting
LAN１ LAN２ LAN３

Configuration Set
〈LAN１〉 〈LAN２〉 〈LAN３〉

〈CONFIGURATION #〉
IP Address

〈169.254.100.100〉 <192.168.100.100> <192.168.100.100>
<IP ADRESS>
Subnet Mask
<SUBNET MASK>

<255.255.0.0> <255.255.255.0> <255.255.255.0>

Gateway Address
<GATEWAY ADDRESS>

<255.255.255.255> <255.255.255.255> <255.255.255.255>

IP Configuration Method Manual Setting DHCP Manual Setting
<IP CONFIGURATION> <MANUAL> <DHCP> <MANUAL>
ARP+PING Enable Enable Enable
<ARP + PING> <ENABLE> <ENABLE> <ENABLE>
Wireless Mode AdHoc Infrastructure AdHoc
<WIRELESS MODE> <802.11 AdHoc> <INFRASTRUCTURE> <802.11 AdHoc>
Channel
<WIRELESS CHANNEL>

<11> <11> <11>

SSID/ESSID
WIRELESS ANY WIRELESS

<WIRELESS SSID/ESSID> <WIRELESS> <ANY（Assigned SSID/ <WIRELESS>
（Uppercase） ESSID is displayed）> （Uppercase）

WEP Encryption Disable Disable Disable
<WIRELESS WEP> <DISABLE> <DISABLE> <DISABLE>
DNS Domain - - -
DNS Address <255.255.255.255> <255.255.255.255> <255.255.255.255>

Contents of Factory Default Setting

Wireless LAN Card inserted （Set to "LAN3" at the factory）

項目 Factory Default Setting
LAN4 LAN5 LAN6

Configuration Set
〈LAN4〉 〈LAN5〉 〈LAN6〉

〈CONFIGURATION #〉
IP Address

〈169.254.100.100〉 <192.168.100.100> <192.168.100.100>
<IP ADRESS>
Subnet Mask
<SUBNET MASK>

<255.255.0.0> <255.255.255.0> <255.255.255.0>

Gateway Address
<GATEWAY ADDRESS>

<255.255.255.255> <255.255.255.255> <255.255.255.255>

IP Configuration method Manual Setting DHCP Manual Setting
<IP CONFIGURATION> <MANUAL> <DHCP> <MANUAL>
ARP+PING Enable Enable Enable
<ARP + PING> <ENABLE> <ENABLE> <ENABLE>
DNS Domain - - -
DNS Address <255.255.255.255> <255.255.255.255> <255.255.255.255>

Wired LAN Card inserted （Set to "LAN4" at the factory）

※Expressions in < > are names projected on the screen when the Test Switch is pressed.

Jiro Ozaki
DHCP
<DHCP>

Jiro Ozaki
DHCP
<DHCP>

Jiro Ozaki
Infrastructure
<INFRASTRUCTURE>

Jiro Ozaki
〈169.254.100.100〉
<255.255.0.0>

Jiro Ozaki
ANY
<ANY（Assigned SSID/
ESSID is displayed）>

Jiro Ozaki
〈169.254.100.100〉
<255.255.0.0>
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Installation of MCI

1. With pressing the Latch Button on the MCI in the direction of the arrow, insert the connector
plug of the MCI into the DVI terminal of the projector. Alongside, press the Mounting Hooks into
the holes on the projector.

2. Release your hand from the MCI when the connector is properly mounted to the DVI terminal.

3. Tighten the screw with a flathead screwdriver to firmly secure the MCI to the projector.

2. With pressing the Latch Button, remove the MCI from the projector.

1. Release the screw with a flathead screwdriver.

Remove MCI from the Projector

Mount MCI to the Projector

Installation of MCI

DVI Terminal

Latch button

Mounting Hooks
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4. Part Names and Functions, Factory Default Setting, Installation of MCI

Insert the Multi Card into the Multi Card Slot of MCI until the Eject Button is pushed off
Caution: "Mutli Card" indicates Wireless LAN Card (CA-30), Wired LAN Card (CA-20) and Compact Flash

Card (CA-10). Do not use undesignated cards which may not properly operate with the MCI and
damage the MCI itself.

- Insert Multi Card

Press the Eject Button to remove the Multi Card.

- Remove Multi Card

Eject Button

Insert / Remove  Multi Card

Optional Multi Card
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5. Software and Installation

5

Install the software nessesary to use the MCI. The
following two applications are included in the
supplied CD-ROM.
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-  MCI Client
MCI Client transmits image data from a
computer to projectors via wireless or wired
LAN and also control/ operate a projector. 
In this chapter, we will install this application. 
It is also possible to run MCI directly from the
CD-ROM if you do not wish to install. 

-  Slide Converter
Slide Converter is an application to convert
PowerPoint, bitmap and JPEG data into the
image data which can be displayed by a
projector. ( Viewer Function)
For details of this software, refer to the separate
manual "Viewer / Slide Converter"
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5. Software and Installation

What is MCI Client

MCI Client transmits image data from a computer to MCI-attached projectors (up to five) via
wireless or wired LAN as well as  remotely controls the projectors operation. 
When a computer is transmitting image data to a MCI-attached projector or controlling its
operation, no other computers can communicate the projector. 

* If you set "Accept Interruptive Connection" as "Enable" on the Web browser, the other computer can

break into the connection. (Refer to " Miscellaneous" of " 8. Configuration with Browser". ）

MCI Client does not support software containing DirectX function, MS-Office Assistant and
replaying motion picture, such as DVD.

Operating Environment

This software requires the following computer environment.

Required Operation System Windows 98 / Me / NT4.0 / 2000 / XP

Requirements when using Over RAM 64MB main memory. (More memory will be required

Windows 98 / Me / NT4.0 / 2000 depending on applications running at the same time.)

Requirements when using Over RAM 128MB main memory. (More memory will be

Windows XP Home Edition / Professional required depending on applications running at the same time.)

Recommended CPU  Higher than Pentium3 600MHz

HDD Disk Drive With more than 100MB free area

Display Setting Support more than one of following resolutions. VGA（640×

480),SVGA(800×600), XGA（1024×768）

Number of colors : Either of 16 bit (65536 colors) or 24/32 bit

（16,77 million colors）

What is Slide Converter

Slide Converter is an application to convert PowerPoint, bitmap and JPEG data into the image
data which can be displayed by a projector. ( Viewer Function)
For details of this software, refer to the separate manual "Viewer / Slide Converter"
To install this software, follow the instruction in this chapter.
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MCI Client 

Slide Converter

Install the Software

Install the Software

Now install the software (MCI Client / Slide Converter)
* When you wish to run MCI Client directly from the CD-ROM, select " Launch MCI Client" at Step 3.

1. Insert the CD-ROM into the CD-ROM Driver.
The software automatically runs and shows the "Select Language" screen. Select the
language you wish to use and press OK button.

Note: If the “Language Selection” screen does not appear automatically, open [CD-ROM drive] of [My
Computer] of your computer and double-click “AutoRun.exe”.  The “Language Selection”
screen will then appear.

2. "Software License window" will be displayed.
Thoroughly read the contents.  If you agree to the contents of the software license
agreement, check on the [Agree] radio button and click [OK].
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5. Software and Installation

3. Main Menu screen will appear.
Select " MCI Client" from the menu on the left.

4. Click " Install MCI Client ".
Install Wizard for MCI client will start up. Then click " Next "
※ If you wish to start up MCI client directly from the CD-ROM, select " launch MCI Client".

5. " License Agreement" screen will appear.
Thoroughly read the contents.  If you agree to the contents of the software license
agreement, check on the [Agree] radio button and click [OK].

Caution: MCI Client and Slide Converter cannot be installed at the same time. Install respectively.  When
you install Slide Converter, click "Slide Converter "  menu on the left side on the screen
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Install the Software

6. Select installing destination 
"Choose Destination Location" screen will appear. Select the location and click OK button.

7. Create a shortcut
If you do not need a shortcut, clear the check box and click Next button. Then the software
starts copying the files from the CD-ROM.

8. Finish the Install Wizard.
When completing the copy of the files, " InstallShield Wizard Complete" screen will appear.
Click " finish" to complete the setup. 
Read the "Readme file" when needed. 
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5. Software and Installation

9. Confirm if the installation is successfully completed.
Select [Start]→ [Program]→ [Multi Card Imager]→ [MCI Client] or double-click the "MCI
Client icon" on the desktop to start up MCI Client. If the screen below is displayed, the
installation is successfully completed. Click button on the top right hand corner. 
※MCI client does not operate at this point. Error message as below will be displayed.

Error message
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6. Wired LAN Configuration

6

This chapter describes how to configurate a wired
LAN environment to connect a computer and
projectors (MCI attached). The following wired
LAN card will be needed for this connection.

Wired LAN Card : CA-20
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6. Wired LAN Configuration

Preparation

1. Insert the wired LAN card : CA-20 into the MCI.

2.  Insert the LAN cable into the wired LAN card. 
※ Confirm the functions of indicators on the MCI and the wireless LAN card.

Setting of the Network Environment

Wireless LAN environment will be set on the Projector Menu.
Detailed setting is available with the browser menu. Refer to "8. Configuration with Browser".

Configuration

1. Select "Wired" from the input menu of the projector.
If "Wired" is not shown on the menu, the wired LAN card may not be properly mounted to
the projector. Check the attachment once again

Caution: Confirm if the Power Indicator on the MCI is lit and the Error Indicator is off.
If the Power Indicator is off and the Error indicator is flashing, check the attachment of the MCI
and restart the projector.

MCI
MCD-100

Wired LAN Card
CA-20

LAN Cable

q

q LNK......Normally lit
w ACT

....Flashes when
receiving / transmitting

data. 
w

Wired LAN Card

Power Indicator Status Indicator
Error Indicator

MCI

MCI has to be installed on the same LAN environment with the MCI Client Computer for its
operation.
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Preparation

Setting of the Network Environment

2. Select "Wired Setting" from the MCI menu.
Select " Wired Setting " from the MCI menu. 

3. Select the LAN configuration you wish to use
Using Point left /right buttons on the top panel / remote control of your projector, select a
network configuration (LAN 4, LAN5, or LAN6) you wish to use. Pressing the Point button
toggles "LAN4", "LAN5", "LAN6" and "Off" in order.The message " Wait a moment" appears
when switching LAN configurations. At the factory, LAN 4 is selected.

✐ Selecting LAN configurations ✐ 
MCI has three preset network configurations (LAN1,
LAN2 and LAN3) . At the factory, LAN3 is selected.
For details of factory default setting, refer to " 4.
Factory Default Setting.
Select the closest configuration you wish to use. 
When you set the IP address manually, select
LAN4 or LAN6. When the DHCP server on the
network assigns the IP address, select LAN5.

4.  Display the Network Configuration Screen.
Press Select button to display the network configuration screen. Contents of the selected
LAN configuration will be displayed. Enter the value in each parameter. For details of each
parameter, contact your system administrator. 

5. Press SELECT button to complete the configuration.
Confirm if the configuration is properly completed. (See next page)

* The above diagram is the preset value of LAN 4

* IP address can be set using  "arp +
ping" command. (See P94)

Wired Setting MCI
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6. Wired LAN Configuration

1. Start up the MCI Client on your computer.
MCI Client starts to search MCIs. If configured projectors are shown on the window of the
MCI client, your computer is properly connected to the projectors via wired LAN. If
" Troubleshooting" dialog appears, your computer is not connected to projectors. Check the
message on the "Troubleshooting" screen and search again.     

Caution: MCI located in the different segment cannot be connected. Specify the IP address. For details,
refer to "Checking the operation" in 7. Wireless LAN Configuration on Ｐ38.

Checking the Operation

MCI Client
Computer

MCI
Wired LAN card inserted.

Error ScreenMain Screen

Search button Window
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Setting of the Network environment

Password Setting

Set the password to restrict access to the MCI through the network.
Once the password is set, you will be required to enter the password when accessing the MCI.

1. Select "Password" from the MCI menu.
"Password" setting screen will be displayed.

2. Enter password
Enter the password using Point up/down buttons (4 digit-number) and then press SELECT
button. Enter "0000" if you do not need a password.

Setting password is recommended when you connect the MCI to network.
The password can be also checked and changed by browser.

Password Setting
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6. Wired LAN Configuration
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7. Wireless LAN Configuration

7

This chapter describes how to configurate a
wireless LAN environment to connect a computer
and projectors (MCI attached). The following
wireless LAN card wil l  be needed for this
connection.

Wireless LAN Card : CA-30
When you connect your computer and the
projector(MCI attached) via wireless LAN, your
computer has to be equipped with a wireless LAN
card adapter which supports IEEE 802.11b. 

If you connect in Infrastructure mode, an access
point which supports IEEE 802.11b wil l  be
required. 
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7. Wireless LAN Configuration

MCI has to be installed on the same LAN environment with the MCI Client Computer for its
operation.

Preparation

Insert the wireless LAN card : CA-30 into the MCI.

※ Confirm the functions of indicators on the MCI and the wireless LAN card.

Setting the Network Environment

In the first place, check your wireless LAN environment. For details of wireless LAN connection
, refer to 3. Operation of Multi Card Director.

Wireless LAN environment will be set on the Projector Menu.
Detailed setting is available with the browser menu. Refer to 8. Configuration with Browser.

Configuration

1. Select "Wireless" from the input menu of the projector.
If "Wireless" is not shown on the menu, the wireless LAN card may not be properly mounted
to the projector. Check the attachment once again.
Caution: Confirm if the Power Indicator on the MCI is lit and the Error Indicator is off.

If the Power Indicator is off and the Error indicator is flashing, check the attachment of the MCI
and restart the projector.

MCI
MCD-100

Wireless LAN Card
CA-30

Power Indicator Status Indicator
Error Indicator

MCI Wireless LAN Card

Link
Normally lit
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Preparation

Setting of the Network Environment

2. Select "Wireless Setting" from the MCI menu.
Select " Wireless Setting " from the MCI menu. 

3. Select the LAN configuration you wish to use.
Using Point left/right buttons on the top panel / remote control of your projector, select a
network configuration (LAN 1,LAN2, or LAN3) you wish to use. Pressing the Point button
toggles"LAN1", "LAN2", "LAN3" and "Off" in order.The message " Wait a moment" appears
when switching LAN configurations. At the factory, LAN 3 (AdHoc) is selected.

✐ Selecting LAN configurations ✐ 
MCI has three preset network configurations
(LAN1, LAN2 and LAN3) . At the factory, LAN3
is selected. For details of factory default setting,
refer to " 4. Factory Default Setting.

4. Display the network configuration screen.
Press Select button to display the network configuration screen. Contents of the selected
LAN configuration will be displayed. Enter the value in each parameter.

* The above diagram is the preset value of LAN 3

✐ How to enter numeric value and characters on the configuration screen ✐ 
Pressing Point left/right buttons move field and Point up/down buttons changes values and selects
characters at SSID/ESSID/BSSD field. Characters can be selected among A-Z, a-z and blank(space).
Press Point right button to enter the next character.

a) IP Address......enter the IP address.
b) Sub net.....not required to enter. (Use factory default setting)
c) Gateway......Not required to enter. (Use factory default setting)
d) Connection Status......AdHoc
e) SSID/ESSID/IBSSD......Enter characters ( "WIRELESS" is

entered at the factory)

※ a: Do not use the same IP address of other wireless LAN
(AdHoc) computer

※ e: Specify the same words of your wired LAN enabled

computer. At the factory, WIRELESS”is entered for
SSID/ESSID/IBSSD. Make sure if the wireless channel of
your computer is 11.

※b,c: No need to set in AdHoc Mode.

Following instruction is based on LAN3 configuration.

✐If you use the factory default setting(LAN3)✐

Wireless Setting MCI
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7. Wireless LAN Configuration

5. Press SELECT button to complete the configuration.

1. Start up the MCI Client on your computer.
MCI Client starts to search MCIs. If configured projectors are shown on the window of the
MCI client, your computer is properly connected to the projectors via wireless LAN. If
" Troubleshooting" dialog appears, your computer is not connected to projectors. Check the
message on the "Troubleshooting" screen and search again.                                                        

Parameters and Descriptions

Checking the Operation

Check the configuration is successfully completed and the operation of the wireless LAN connection.

Parameter Description

IP Address..........................Set the IP address in the environment you wish to use.
Sub Net ..............................Set the Subnet mask in the environment you wish to use.
Gateway..............................Set the gateway address in the environment you wish to use.

* If any segment beyond the router is not used, the gateway address can be left
at “255.255.255.255”.

Connection Status ....Set this status in accordance with the communication mode
(Infrastructure or AdHoc) you wish to use.

SSID/ESSID/IBSSID ....In both Infrastructure and AdHoc mode, same charactered have to be
set to the MCI, access point and the wireless-enabled computer.
( up to 32 characters)  Be cautious when entering the characters, since
SSID/ESSID is case-sensitive.            
To set "ANY" for the MCI is not  recommended. 

Error ScreenMain Screen

Search button

※ IP address can be set using "arp + ping" command. (See P94)

Window
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Setting the Network Environment

2. Select a projector
Point the projector you wish to connect with the mouse cursor. The pointed projector will be
highlighted.

3. Click "Capture"  button
Click One-shot Capture button or Real time Capture button. Confirm if the image of your
computer screen is properly projected from the projector.

Caution: MCI Client computer cannot communicate with the projector installed in the segment which is
beyond the rooter. In this case, specify the IP address as following procedure.

1. Click Options button
Click Options button on the main screen. Options screen will be displayed.
Click Add button to show the IP Address screen.

2. Enter IP address
Enter the same IP address as the one set to the projector. (e.g.192.168.100.100)
Click OK button. 

3. The entered IP address is shown in the window
Press OK button to close the Options Screen.
The entered IP address and "MANUAL"is added to the window.

Note: Detailed information of the network can be configured by browser. Refer to "8. Configuration
with Browser" on P41

Options

Real time Capture

One-shot Capture

Add 

Options Screen

Configure with Multi Card
Imager device button (P43)
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8. Configuration with Browser

8

MCI can be set, controlled and operated by the
web browser.

Caution： When you use the web browser, the MCI
needs to be connected to the projector via
wireless or wired LAN. Complete the setup
of the LAN connection.

The web browser can set or operate followings:

・ LAN setting
Configure Wired/Wireless LAN environment.

・ Email Setting
Configure E-mail function to maintain the projector.

・ Operation of  Network Viewer

・ Password Setting
Configure security password to control the projector.

・ Others
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8. Configuration with Browser

Introduction

To operate by web browser, you need to configure its environment.
Check the environment of the web browser and configure to make it possible to operate the
MCI.

Environment of  Web Browser

Web browser is required to support the following version.

Microsoft : Internet Explorer Ver.4.0 or later

Netscape Communications : Netscape Navigator Ver4.6 or later

Configuration of  Web Browser

Configure the operation environment of the web browser. Configuration has to be accurate for
proper operation.

Using Proxy Server

Internet Explorer
Start up Internet Explorer.  Select [Tools] > [Internet Options].  Select the [Connection] tab and
click the [LAN Setup] button in the [Local Area Network (LAN) Setup] field.  Click the [Details]
button in the [Proxy Server] field.  Input the IP address set on the MCI in the [Proxy server is not
used at address starting from the following IP address] field.

Netscape Navigator
Start up Netscape Navigator.  Select [Edit] > [Setup] > [Category].  Select [Details] and [Proxy],
and check on [Set proxy manually.].  Click the [Display] button and input the IP address set on
the MCI in the [Proxy server is not used at address starting from the following IP address] field.

Not using Proxy Server

Internet Explorer
Start up Internet Explorer.  Select [Tools] > [Internet Options].  Select the [Connection] tab and
click the [LAN Setup] button in the [Local Area Network (LAN) Setup] field.  Check off [Proxy
server is used at local address] of the [Proxy Server] field.

Netscape Navigator
Start up Netscape Navigator.  Select [Edit] > [Setup] > [Category].  Select [Details] and [Proxy],
and check on [Connect Internet directly.].
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Environment of Web Browser

Configuration of Web Browser

Starting up the Web Browser

Starting up the Web Browser

Start up the MCI Client. Select the projector to be configured and click " Configure Multi Card
Imager device" button.(See page 39) "Multi Card Imager Configuration" screen will appear.

Items to be configured are shown in MENU on the light side of the screen.
Note: MCI Configuration screen can be also displayed by entering the IP address directly on the

browser's URL.  (e.g. http://00.00.00.00)

Information

On the initial screen, the setup contents and current status of the MCI are displayed. The
contents is varied by Wired or wireless LAN environment.

Screen of Wireless LAN

Screen of Wired LAN

Configure Multi Card
Imager device
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8. Configuration with Browser

* Not shown when wired LAN card is attached.

Parameter Description

Firmware Version ..............................Shows the firmware version of this system.

Boot ROM Version ..........................Shows the boot ROM version of this system.

Wireless Card Type* ........................Shows the countries in which the device can be used.

This unit is set to “US” and cannot be changed. 

IP Address ......................................Shows the IP address currently set on this system.  If DHCP is set, the

IP address assigned from the DHCP server is displayed.

Wireless Link Status*......................Shows the wireless communication mode and its status of this system.

WEP Security* ................................Shows the WEP (Encryption) setting status.

However, the WEP key is not shown.

Current SSID/ESSID* ......................Shows SSID set on this system.

Current Channel*......................Shows the channel, through which this system is currently

communicating.

Data Transfer Rate* ........................Shows the current wireless communication speed of this system.  The

communication speed is automatically changed by the environment at

that time (11 Mbps, 5.5 Mbps, 2 Mbps, or 1 Mbps).  The

communication speed cannot be set at a fixed rate.

Current User/PC ............................Shows the IP address of the personal computer, which is currently

transferring images to this system using MCI Client.

System Time ..................................Shows the elapsed time since the power is turned on.

The time can be reset by selecting “Reset” from the browser

configuration screen, or by disconnecting power from the projector and

connecting back on.

Projector ..........................................Shows the name of MCI attached projector. (Can be changed)

Refresh button ................................Refreshes the displayed data.

Parameters and descriptions of Information
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Quick Setup

Quick Setup

Quick Setup includes minimum setup items required for operating the MCI.
The contents of this page is a part of the advanced setup page. Therefore, the contents set on
this page may affect relevant items on the advanced setup. If you set the items on the
advanced setup page, the settings on this page are not necessary.
Depending on the inserted LAN card, wireless or wired, setting items will be varied.
To reflect the setting on the MCI, click APPLY button. For details of each item/button, refer to
the next page.

Wireless LAN card inserted

Wired LAN card inserted
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* Not displayed when wired LAN card is inserted to the MCI.

Parameter Description

Projector ..................................Name the projector(MCI) to distinguish it from others. (up to 32
characters). The name set here will be displayed on the main screen of
MCI client. 

IP Configured Method ....................A desired IP address setup method is selected from [Manual], [DHCP],
and [BOOTP].
If [DHCP] or [BOOTP] is selected, the IP address is obtained
automatically as [DHCP client] or [BOOTP client].  At this time, it is
necessary that the DHCP server/BOOTP server must be in the
environment allowing the network communication.
When the IP Address Configuration Method is set to DHCP or BOOTP,
and you press the test switch to display the settings while the MCI is
attempting to obtain an IP address, IP Address, Subnet Mask, and
Gateway Address fields will display [-.-.-.-].
If the MCI fails to obtain IP address from the DHCP server, these fields
also show [-.-.-.-] and the MCI is not communicated. If the MCI fails to
obtain IP address from BOOTP server, the existing IP address will be
assigned.

IP Address ......................................Set the IP address in the environment you wish to use.
If [IP Configuration Method] is set to [DHCP] or [BOOTP], this setting is
not needed.

Subnet Mask ..................................Set the Subnet mask in the environment you wish to use.
If [IP Configuration Method] is set to [DHCP] or [BOOTP], this setting
may become unnecessary depending on the settings of [DHCP Server]
and [BOOTP Server].

Gateway Address ............................Set the gateway address in the environment you wish to use.
If [IP Configuration Method] is set at [DHCP] or [BOOTP], this setting
may become unnecessary depending on the settings of [DHCP Server]
and [BOOTP Server].
If any segment beyond the router is not used, the gateway address can
be remained “255.255.255.255”.

Wireless Mode*..............................Set the wireless communication mode in the environment you wish to use.
Select either “Infrastructure” or “AdHoc”.

Channel*..............................................If you use the MCI in 802.11AdHoc mode, select the channel, from 1 to 11.
SSID/ESSID* ..................................Set the SSID/ESSID. (up to ASCII 32 characters)

SSID/ESSID is case-sensitive.  Even though all characters projected by
pressing the TEST switch on Multi Card Director are uppercase, it is
necessary to distinguish between upper and lower case characters.

APPLY button ..................................If the contents you have set on this page are correct, click the [APPLY]
button. The screen to restart the MCI will be displayed. To enable your
new settings, click RESTART button.

REFRESH button ............................Cancel the new settings.
RESTORE Factory Default

Settings button ............Restore the settings to the values at the factory.
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Parameter Description

IP Configuration Method ..........A desired IP address setup method is selected from [Manual], [DHCP],
and [BOOTP].
If [DHCP] or [BOOTP] is selected, the IP address is obtained
automatically as [DHCP client] or [BOOTP client].  At this time, it is
necessary that the DHCP server/BOOTP server must be in the
environment allowing the network communication.
When the IP Address Configuration Method is set to DHCP or BOOTP,
and you press the test switch to display the settings while the MCI is
attempting to obtain an IP address, IP Address, Subnet Mask, and
Gateway Address fields will display [-.-.-.-].
If the MCI fails to obtain IP address from the DHCP server, these fields also
show [-.-.-.-] and the MCI is not communicated. If the MCI fails to obtain IP
address from BOOTP server, the existing IP address will be assigned.

IP Address ......................................Set the IP address in the environment you wish to use. If [IP configuration
Method] is set to [DHCP] or [BOOTP], this setting is not needed.

Subnet Mask ..................................Set the Subnet mask in the environment you wish to use. If [IP Configuration
Method] is set to [DHCP] or [BOOTP], this setting may become unnecessary
depending on the settings of [DHCP Server] and [BOOTP Server].

Gateway Address ............................Set the gateway address in the environment you wish to use.
If [IP Configuration Method] is set at [DHCP] or [BOOTP], this setting
may become unnecessary depending on the settings of [DHCP Server]
and [BOOTP Server]. If any segment beyond the router is not used, the
gateway address can be remained “255.255.255.255”.

ARP+PING ......................................Select "Enable" or "Disable" the IP address setup using "arp" and "ping"
(Refer to P94 for details)

domain ......................................................Enter the domain name where the MCI belongs. (up to ASCII 254 characters)
DNS Server......................................Enter the address of the DNS server.
APPLY button ..................................If the contents you have set are correct, click the APPLY button. The screen

to restart the MCI will be displayed. To enable your new settings, click
RESTART button.

REFRESH button ............................Cancel the new settings.
RESTORE Factory Default Settings button Restore the settings to the values at the factory.

Advanced Setup

TCI/IP related items can be configured on
this page.

TCP / IP
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Wireless related items can be configured
on this page.
This page is not shown when the wired
LAN card is inserted in the MCI.

Parameter Description
Wireless Mode................................Set the wireless communication mode in the environment you wish to

use. Select either “Infrastructure” or “AdHoc”.
Channel................................................If you use the MCI in 802.11AdHoc mode, select the channel, from 1 to 11.
SSID/ESSID* ..................................Set the SSID/ESSID. (up to ASCII 32 characters)

SSID/ESSID is case-sensitive.  Even though all characters projected by
pressing the TEST switch on the MCI are uppercase, it is necessary to
distinguish between upper and lower case characters.

WEP Security ..................................Select "Enable" or "Disable" the WEP(encryption).
When using WEP, select any of [Enable (40bit/Shared Key)], [Enable
(40bit/Open System)], [Enable (128bit/Shared Key)], and [Enable
(128bit/Open System)] corresponding to this WEP.
When enabling WEP (Encryption), the image transfer speed may become
slower.

WEP Key#1- Key#4 ........................Set WEP key in the hexadecimal notation (0 to F). 5 bytes are set for 40-

bit WEP and 13 bytes are set for 128-bit WEP.Four WEP keys can be

set, however, the only one with check on its radio button is in effect.

Both of the number and value of the WEP key in effect must be same as

those of your PC and the access point.

Depending on computers and access points, you may be allowed to

select only one WEP key. In this case, use WEP key 1.

APPLY button ..................................If the contents you have set on this page are correct, click the APPLY

button. The screen to restart the MCI will be displayed. To enable your

new settings, click RESTART button.
REFRESH button ............................Cancel the new settings.
RESTORE Factory Default

Settings button ............Restore the Wireless Settings to the values at the factory.

Wireless Setting
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MCI has a function to send an email to inform its operating condition to the administrator or
users. To use this function, the MCI needs to be provided with the IP address which can
communicate to the SMPT server. This function is available only for wired LAN and wireless
LAN in infrastructure mode.

Parameter Description
SMTP Server ..................................Enter the address of SMTP server,。(up to ASCII254 characters)

Administrator Address ....................Enter the E-mail address of administrator.

Mail Address ..................................Enter E-mail addresses of users.

Option..............................................When the checked item has occurred, the MCI send alert messages.

Attached Message ..........................Attach the message to the email. (up to 110 characters)

APPLY button ..................................If the contents you have set on this page are correct, click the [APPLY]

button. The screen to restart the MCI will be displayed. To enable your

new settings, click RESTART button.
REFRESH button ............................Cancel the new settings.
RESTORE Factory Default Settings button ..........Restore the E-mail Settings to the values at the factory.

E-mail Setting
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If the Admin Password is set, no one but the system administrator can change the setting
contents of the MCI. At the factory, the Admin Password is not set.

Parameter Description

Enter Current Admin Password ......Input the currently set admin password.  The password you have input is

shown like “●●●●●●●”.（up to ASCII16 Characters）

Enter New Admin Password ..........Input a new admin password you wish to set.  The password you have

input is shown like “●●●●●●●”. （up to ASCII16 Characters）

Re-enter New Admin Password......Re-enter the new admin password you wish to set. The password you

have input is shown like “●●●●●●●”.（up to ASCII16 Characters）

APPLY button ..................................If the contents you have set on this page are correct, click the APPLY

button. The screen to restart the MCI will be displayed. To enable your

new settings, click RESTART button.

If you set the admin password for the first time, do not input any password in the [Enter Current
Admin Password] field.  Enter a password in [Enter New Admin Password] and [Re-enter New
Admin Password] fields.

When you change the settings next time, the password will be required to enter. Leave the
"User name" field blank and enter the password you set.

Admin Password
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Advanced Setup

The User Password can be set to restrict the access to the MCI.
The password different from the Admin Password can be set for the User Password.
When you reset the User password, you do not need to enter the current password.
At the factory, the User Password is not set.
If you do not need a password, enter "0000".

Parameter Description

Enter New User Password..............Input a new password you wish to set.  The password you have input is

shown like “●●●●”. (4 figures)

Re-enter New User Password ........Re-enter the new password you wish to set.  The password you have

input is shown like “●●●●”. (4 figures)

APPLY button ..................................If the contents you have set on this page are correct, click the APPLY

button. The screen to restart the MCI will be displayed. To enable your

new settings, click RESTART button.

User Password
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You can name the projector and set Interruptive Connection on this screen.

Parameter Description

Projector ..................................Name the projector(MCI) to distinguish it from others. (up to 32
characters). The name set here will be displayed on the main screen of
MCI client. 

Accept Interruptive Connection ......Enable or Disable the interruptive connection to the projector which is

connected to other computer when you send images using MCI Client.

（See "9. Display Image via Network" for further detail.)
APPLY button ..................................If the contents you have set are correct, click the APPLY button. The screen

to restart the MCI will be displayed. To enable your new settings, click
RESTART button.

REFRESH button ............................Cancel the new settings.
RESTORE Factory Default 

Settings button ......Restore the miscellaneous settings to the values at the factory.

Miscellaneous
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Changing Configuration Set

Changing Configuration Set

Select a set of LAN settings to be enabled from LAN1, LAN2 and LAN3. Besides it, setting
values of LAN1, LAN2 and LAN3 ( Projector name, IP Configuration Method, IP Address,
Wireless Mode, Channel, SSID/ESSID, WEP Security) can be checked on this screen.
Depending on the inserted LAN card, wireless or wired, setting items will be varied.

Parameter Description

LAN1 LAN2 LAN3* ........................Select a LAN setting from LAN1, LAN2 and LAN3
APPLY button ..................................If the contents you have set are correct, click the APPLY button. The screen

to restart the MCI will be displayed. To enable your new settings, click
RESTART button.

REFRESH button ............................Cancel the new settings.

WIreless LAN card inserted

Wired LAN Card inserted

* When wired LAN card is inserted, LAN4, LAN 5 and LAN6 will be displayed.
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Restart

You can reboot the MCI on this screen.
To activate the new settings, the MCI has to be restarted. Click RESTART button to reboot the unit.

Parameter Description

RESTART button ........................Click this button when you restart the MCI after completing the

settings.

CANCEL button ..............................Cancel to restart the MCI.
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9. Display Image via Network

9

Using MCI Client, you can display the image on
your computer screen from the projector via
network.
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9. Display Image via Network

Displaying Image on the PC screen to the Projector

1. Start up the MCI Client
To activate the MCI Client, select [Start] > [Program] > [Multi Card Imager] > [MCI Client] in
that order.
As soon as the MCI Client is activated, it starts searching projectors and displays the list of
available projectors on the network. If the projector you wish to connect is not shown on the
list, click the Search button.
Caution: MCI located in the different segment cannot be connected. Specify the IP address. For details,

refer to "Checking the operation" in 7. Wireless LAN Configuration（Ｐ38）
Memo: While the MCI Client is activated, the icon appears in the system tray. For details of this icon,

refer to "MCI Client Icon in the System Tray" on P58.

Search button

Stop Capture button

One-shot Capture button

Real time Capture button

Options button

2. Select the projector you wish to display image
Select the projector you wish to transmit the image data from the list. If you wish to select
two or more, select them with pressing down Ctrl key on the keyboard. Up to 5 units can be
selected.
Selected projector will be highlighted. The projector showing " Connecting " is currently being
used. You cannot connect this projector.

3. Configure the conditions of image transmission
Click Options button to display the Options Screen.
Configure the conditions of image transmission on this screen.（See the next page for details.)
To reflect the new configuration, click OK button.
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Displaying image on the PC

screen to the Projector

Parameter Description

Automatic ........................................Automatically select the most suitable compression method..

Optimize for Performance ..............Optimize for switching speed of image.

Optimize for Quality ........................Optimize for image quality.

Optimize for Photo Images ............Select this when capturing photo images.

Compression Method

Parameter Description

Automatic ........................................Capture the image when any change occurs on the computer screen.

Always capture whole screen ........Constantly capture the image on the computer screen.

Screen Capture Settings *Reflected for Real-time Capture

4. Display the image on the computer screen to the MCI

Parameter Description

Real time Capture button ................Transmit the image to the projector in real-time.

One-shot Capture button ................Transmit the image to the projector when you press this button.

Stop Capture button ........................Stop the real-time capturing.

If the password is set, Password Input Screen will appear. 

（Refer to Password Setting in "Chapter 8 Configuration with Browser" )

Memo: While executing real-time capture, no buttons can be clicked other than Stop button. The
transmitted image are kept in the MCI and displayed until the projector is turned off or the MCI
is restarted, even if you close the MCI Client.
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MCI Client Icon in the System Tray

Parameter Description

Set to Default ................................Save the following information. MCI Client will be activated with this

saved settings from the next time. This function is not available when

you activate the MCI Client directly from the CD-ROM.
・Options settings
・Connected projectors
・Transfer mode
（Real time Capture, One-shot Capture or Disconnect）
・User Password

About MCI Client ............................Show version information.

Help ................................................Show help information.

Open................................................Activate the window of the MCI Client.

Quit..................................................Quit MCI Client.

When right-clicking the icon in the system tray, the following menu will be shown.

The icon will be
changed (Lighted on)
when MCI Client is
connected to the MCI.
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About User Right to Login

Notes on the case where you log into Windows XP Professional/Windows XP

HomeEdition/Windows2000 Professional with user right (right other than administrator right) 

If you log into Windows XP Professional/Windows XP HomeEdition/Windows2000 Professional
with user right (right other than administrator right), the following error message will appear
when you start up the MCI Client.
Check whether the IP address of the MCI and that of your computer are in an accessible system
for each other.  If it is not accessible, change the setting of the IP address by either of the
following methods.

1. Login again with administrator right, and change the IP address of your computer for an
accessible system.  After setting, log into your computer with user right. 

2. Login again with administrator right, and change the IP address of your computer which is
possible to communicate with the MCI.  After setting, log into your computer with user right. 

Before starting up the MCI Client, set [Hardware acceleration] to [None].  ([Hardware
acceleration] is located in [start] - [Control Panel] - [Display] - [Settings] - [Advanced] -
[Troubleshoot].) to make the projection speed faster.  This setting is, however, not available with
user right (right other than administrator right).  In this case, first login with administrator right
and set [Hardware acceleration] to [None], and then log into your computer with user right
again.
If the setting of [Hardware acceleration] remains [Full], the processing speed of the projected
image is slower compared to [None] (default). 
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10. PJ Controller

10

PJ Controller offers the following functions:

・Controlling the projector
- Monitoring the projector condition.
- E-mail function to inform the projector

condition to users.

・Operating the projector

・Operating Network Viewer

・Controlling the projector menu.
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10. PJ Controller

Preparation

1. Start up the MCI Client
To activate the MCI Client, select [Start] > [Program] > [Multi Card Imager] > [MCI Client] in
that order. Detected projectors will be displayed on the main screen.

✐  Connecting the projector separated by a rooter✐

MCI Client computer cannot connect to the projector installed in the segment beyond the rooter
cannot be connected. In this case, click Options button to show the Options Screen.

q Click Add button to display the IP Address Screen.
w Enter the same IP address as the one set to the projector. (e.g. 192.168.100.100)
e Click OK button to close the window. The entered IP address will be added to the

Known Devices List.

Options button

Enter the IP address

The entered IP address will be
shown here.
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Preparation

2. Select the projector and click the PJ Controller button
* The projector showing "Connecting" cannot be controlled by PJ Controller.
* PJ Controller can control a single projector only.

3. PJ Controller is activated.
The screen below will be displayed. 
The left side is "Main Menu". Select the setting item you wish to control/adjust. 
Control items or condition items of the selected setting item are shown on the right side.
"Initial Setting "is shown on the initial screen.

r Press OK on the Options screen. The IP address and "MANUAL" will be shown on
the main screen.

The entered IP address 
will be added.

PJ Controller button

Main Menu
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Initial Setting

Before using the PJ Controller function, initial setting will be required.

1. Select Initial Setting from the main menu and configure each item.

Main Menu

2. After the Initial Setting, configure each item
Once the initial setting is completed, then go to other items to configure / control.

3. Exit from PJ Controller
To exit from PJ Controller, select [File] > [Exit]
Memo: Real-time Capture and One-shot Capture are not available with the computer using PJ controller

function.

Parameter Description

Language ........................................Select a desired language from the pull-down menu, and click [Set] button.

Model Name....................................Select a model name of the projector to which the MCI is installed.

* Model Name is listed as code in OPTIONAL PARTS section of the

projector’s owner’s manual. PJ Controller can not be functioned with a

wrong code. 

Temperature....................................Select Centigrade or Fahrenheit from the pull-down menu and click Set

button.

Comment ........................................You can store any comments regarding the initial settings.  To save the

comments you entered, click [Save] button.
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Initial Settings

Email Setting

E-mail Setting

MCI has a function to send an email to inform its operating condition to the administrator or
users. MCI has a function to send an email to inform its operating condition to the administrator
or users. Select E-mail Setting from the main menu and configure each item as follows:

1. Register E-mail Address

* The SMTP server is a server for sending E-Mail. Please contact your network administrator to have this
SMTP server address.

* To use the E-mail function, it must be set the DNS address correctly.( See "TCP/IP" in "8. Configuration
with Browser".)
You cannot use this E-mail function if the DNS server and SMTP server cannot be used in your network
environment. If the SMTP server is located in your LAN (Local Area network), the address set to SMTP
server should be specified the in SMTP server located in your LAN. The server located outside of your
LAN may not be available for security reason. For further information please contact your network
administrator.

Parameter Description

SMTP Server ..................................Enter the address of SMTP server and click Set button.

Administrator Address ....................Enter the E-mail address of administrator and click Set button

Mail Address ..................................Enter E-mail addresses of users and click Set button

To delete the E-mail address, click Delete button.
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2. Check Option items
Check the conditions where you would choose the MCI to send alert messages.
※ Regarding the alert message, see below samples. 

3. Input the message to attach the E-mail. 
The message typed here will be attache to the alert message.

Samples of Alert Message

* When the internal temperature is too high

TITLE: Message from projector
Projector Model Name: XX100
TCP/IP: 192.168.0.111｠｠｠ Projector Name:

It sends you following message.

*The Projector lamp is turned off, because internal projector temperature is too high..
｠ Wait for Temperature Warning Indicator turned off, and then turn the Projector on again.
If the Indicator continues flashing, check the air filter for dust accumulation.

[A]｠21.5degrees centigrade[B] -13.7degrees centigrade[C]｠51.6degrees centigrade
Temperature of Sensor B is too high.
Temperature of Sensor C is too high.

* When the internal power circuit is failed

TITLE: Message from projector
Projector Model Name: XX100
TCP/IP: 192.168.0.111｠｠｠ Projector Name:

It sends you following message.

*The Projector lamp is turned off, because projector power circuit is failed..
｠Unplug this projector from AC outlet and ask servicing to qualified service personnel.

* When the life span of the lamp has been expired

TITLE: Message from projector
Projector Model Name: XX100
TCP/IP: 192.168.0.111｠｠｠ Projector Name:

It sends you following message.

*The life-span of lamp is reached.
｠Lamp replacement is required.

* The Network Unit let users know the information which thermal sensor [A], [B] or [C] inside the
projector detected the abnormal temperature risen and so the projector was turned off. Please refer to
item “Check the status of projector” for the location of the sensors [A], [B] and [C], and temperature (+
p.39). Also see the owner's manual of the projector for further details.

* The Projector lamp was turned off, because the projector power circuit failed.
Unplug the projector from AC outlet and ask servicing to a qualified service personnel 

* Replace it with a new lamp immediately and reset the lamp counter. If the projector is used without
reset the lamp counter, the alert mail is sent to users in every power-on of the projector. 
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Power & Status

Power & Status

Click "Power & Status" on the main menu and configure each item.

1. Turn on/off the projector
Click Standby / ON buttons to turn off / on the projector. When pressing the Standby button,
the confirmation message will appear. Click OK to turn off the projector.
Note: Projector cannot be turned on for approximately 90 seconds after it being turned off.  When the

display of "Power Status" changes from " On cooling down" to " On", click ON to turn on the
projector.

✐ Caution about turning on / off the projector via network ✐ 

When you wish to turn on / off the projector via network, preset the projector as follows:
1. Select "Setting" from the Projector menu.
2. Select "Standby mode" from the Setting menu and set it as "Normal".
If you set this function as Normal, the MCI is constantly provided with power even if the

projector is turned off. If you set this as Eco, then the MCI will be turned off when you turn
off the projector. Consequently, you cannot turn on / off the projector via network. 

Confirmation Message

Select "Standby Mode" and set
it as Normal.
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2. Check the status of the projector
The following items can be checked on the Power & Status screen.

Parameter Description

Accumulated lamp-use time............Displays accumulated time of lamp use in hour increment.

Accumulated projector-use time ....Displays accumulated time of projector use in hour increment.

Power Status ..................................Displays the status of the projector's lamp as follows:

On, Standby, On cooling down, Power Saver Mode/On cooling

down, Temperature Error/On cooling down, On starting up,

On power management operating, Temperature Error/Standby

Projection Condition ........................Displays the projector's condition as follows:
Normal, Temperature Error, Power Failure

Input Status ....................................Displays the following input status 

Input............................Displays selected input mode.

Selection ....................Displays selected input source mode.

Signal Status ..............Displays signal status.

Internal Temperature ......................Displays detected internal temperature of the projector.

The icons A, B and C stands for the thermal sensors inside the

projector. If the internal temperature exceeds the certain point, each

icon changes as below and let users know the error. Check the air filters

and surrounding area of exhaust and intake vents of the projector.

Icon A, B and C are located as follows: 
A: Ambient temperature of the projector
B: Ambient temperature of the 
C: Ambient temperature of the lamp

* The ambient temperature of the projector may be shown a little higher than
the actual temperature.
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Control

Control

When you select Control from the main menu, Control Menu will appear at the bottom of the
screen. Using this menu, you can adjust or configure the projector.
Caution: Control items displayed on this screen is varied depending on the input source or product model

of the projector. So the figures shown in this section may be different from the actual screen
displayed on your computer. For further detail, refer to the owner's manual of your projector.
This function is not available if the projector is turned off.

Input

On this screen, you can select input source of the projector. Check the input terminal and select
the signal mode from the pull-down menu. Click Set button to switch the input.
You can save a note in Comment field. Click Save button to save the note.

Parameter Description
Wireless ............Select this input when using network

capture or viewer function.
Computer 2 ........Select the input source from RGB,

Component ,  and RGB (Scart)
Video ..................Select the input source from AUTO,

VIDEO, and S-CVIDEO.

Control Menu
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PC Adjustment

This feature optimizes the signal from the
connected computer to display the screen. 

* PC Adjustment screen is displayed only when
Computer 2 (RGB) is selected for the input
source.

Parameter Description

Current Mode ..................Displays computer mode

Auto PC Adjustment ........Executed by clicking Start button.

Fine sync ..........................Click 7 8 to adjust the value

Total dots ..........................Click 7 8 to adjust the number to fit your computer image.

H Position ........................Click 7 8 to adjust the horizontal position.

V Position..........................Click 7 8 to adjust the vertical position.

Clamp................................Click 7 8 to adjust the clamp level.

Display Area H ..................Click 7 8 to decrease/increase the value to fit resolution of the image.

Display Area V ..................Click 7 8 to decrease/increase the value to fit resolution of the image.

Full Screen ........................Displays the image in the full screen size.

Load Setting No. ..............Loads the preset settings(Mode 1-5) 

Save Setting No. ..............You can save the settings of the PC Adjustment. Select the mode number you

wish to save and click Set button. 
※If you want to delete the content in the mode. select the mode and click "Mode free" button.

Comment..........................You can save a not regarding the PC Adjustment. Click Save button to save the

note.



E
n

g
li
s
h

71

Control

SYSTEM Adjustment

On this screen, you can select color system and scan mode for the video signal. This screen is
displayed only when Video (Video/Component) is selected for the input source of the projector.
Depending on the signal, the screen is varied as below.

Component Input

VIDEO/S-VIDEO Input

Parameter Description

System Adjustment ..........Select a scan mode of

component signal.

AUTO ........................Automatically adjust to the

scan mode of the input signal.

Parameter Description

Color System Adjustment

......................Select a color system of

Video/S-Video signal.

AUTO................................Automatically adjust to the

color system of the input

signal.

Note: Items in System Adjustment are displayed only for video input (video/Component).
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Image Adjustment

On this screen, you can adjust the image
projected from the projector. Select an
Image Adjustment Mode from the pull-
down menu and  click Set button. The
items displayed on this screen is
automatically changed according to the
input signal. Click 7 8 buttons to adjust the
value. Everytime you change the value,
click Set button. if you click Reset button,
all the adjusted values will be reset. 

*  Some items may not be adjusted depending
on the functions of your projector or input
signal. In this case, " ----" will be shown in the
field of the item.

* Items only for computer input.
** Items only for video input.
*** If the color system is PAL, SECAM, PAL-M or PAL-N, tint cannot be adjusted.

Parameter Description

Image Adjustment Mode....Select from Standard, Real*, Cinema**, Image 1 – 4, from the pull-down list.

Image 1 - 4 can be set by users.

Original Mode ..................Displays the original mode.

Contrast ..............................Click 7 8 to adjust the image contrast.

Brightness ..........................Click 7 8 to adjust the image brightness.

Tint ......................................Click 7 8 to obtain proper image.***

Color ....................................Click 7 8 to adjust the color intensity.

White Balance

Color Temp. ....................Click 7 8 to adjust the color temp level. (XLow, Low, Mid or High)

Red, Green, Blue ............Click 7 8 to adjust white balance of the image.

Sharpness ..........................Click 7 8 to adjust the image sharpness.

Gamma ..............................Click 7 8 to obtain better balance of contrast.

Progressive＊＊ ................Switches progressive mode : Off, L1(motion picture), L2(still picture)

Comment..........................You can save a note regarding Image Adjustment. Click "Save" button to save the note.

Store....................................You can save the settings of the Image Adjustment. Select the mode number

you wish to save and click Set button. If you click Reset button, all the adjusted

values will be reset.
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Screen

You can select a screen mode on this screen. The items displayed on this screen is
automatically changed according to the input signal.

Note: If “1080i”, 1035i”, or “720p” scan mode is selected from [System Adjustment] (Y, Pb/Cb, Pr/Cr
input only) setting in [SYSTEM] screen, you cannot configure [Screen] settings.

Sound

On this screen, you can adjust sound volume of the projector.

Parameter Description

Parameter Description

Aspect ................Select Normal or Wide.
True＊ ................Provides image in its original size. To

activate this function, click ON button.
Digital Zoom＊ ..Click +, or _ button to enlarge or

minimize the screen size. Click OFF to
cancel this function.

＊ Items only for Wireless, Wired or Computer2 (RGB) 
input mode.

Volume ..............Click 7 8 to adjust volume.
Mute ..................Click ON to mute the sound and OFF to

cancel this function.
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Setting

On this screen, you can configure he
projector. Refer to the below table for each
item and description.

* The items displayed on this screen is varied
according to the functions provided to the
projector.

Parameter Description

Language ..........................Select the desired language from the pull-down menu.

Keystone ..........................Click 7 8 ed buttons to correct keystone distortion.

Check the HighSpeed box if you wish to increase the variation.

......................................Click OFF if you do not need this function.

Blue Back ........................Select [ON] or [OFF] to display/not display blue background when no signal is

detected.

Display ..............................Select [ON] or [OFF] to display/not display the screen.

Logo..................................Select the image to show on the starting-up display from User, Default or OFF. 

Capture ............................Click YES to capture the projected image. The captured image can be used for

the starting-up display.(Select "User" for Logo )

Ceiling ..............................By clicking [ON] button, the image gets reversed vertically and horizontally to

adjust to ceiling-mount projection.

Rear..................................By clicking [ON] button, the image gets reversed horizontally to adjust to rear

projection.

Terminal ............................Select Computer 2 or Monitor Out from the pull-down menu.

Standby Mode ..................Click Normal or Eco to set the Standby Mode.

No Show ..........................By clicking [ON] button, the image will be temporarily hidden from view.

Freeze ..............................By clicking [ON] button, the image will temporarily freeze.

Power Management ........Select Ready, Shut Down or OFF from the pull-down menu. Enter the count-

down time by clicking 7 8 buttons. 

* The figure is a part of the whole screen.
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Control

Parameter Description

On Start ............................By clicking ON button, the projector will be automatically turned on when the

power plug is connected to AC outlet.

Lamp Mode ......................Select the Lamp Mode from Normal, Eco and Auto. 

Pointer ..........................Select the shape of the Pointer from Spotlight-S, Spotlight-M, Spotlight-L,

Pointer, Finger and Laser.

Remote Control ................Select Remote Control Code from Code1 to Code 8. If you change the code here,

you have to change the code of the remote control unit at the same time.

Key Lock ..........................To lock the projector, select Projector Keys (Locks the top panel operation)or

Remote Control (Locks the remote control operation). If you do not need to lock,

select None.

Lamp Counter Reset ........You can reset the lamp counter. 

...................................... * Reset the lamp counter only when you change the lamp.

Factory Default ................If you wish to reset all the values you set in the control menu, click Yes.

P-TIMER............................When you click [P-TIMER] button, the timer will appear on the projected screen.

Click again and the elapsed time will appear.  Click again and the timer will

disappear.
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10. PJ Controller

Service

Items on this screen are used for maintenance of the projector.

* If you select WIred, Wireless or Computer 2 (RGB) for
the input source, these items are not shown.

Save Actual Adjustment

On this screen, you can save and load the setting. The items you can save is as follows: Input
mode, PC Adjustment, System Adjustment, Image Adjustment, Screen and Setting.

Parameter Description

Fan Control Speed

........................Select Max or Normal.
Video System* ....Displays the current video system.
Horizontal* ........Click 7 8 buttons to adjust horizontal

screen size.
Vertical* ..........Click 7 8 buttons to adjust vertical

screen size.
Position* ..........Click 7 8ed buttons to adjust the

screen position.
Initialize* ............Reset all the service items to the factory

default settings.

*The figure shows only part of the full screen.

1. Confirm the actual adjustment
When you click Save icon in the Control Menu,
the "Save Actual Adjustment" screen will
appear. Check each setting. (Go to the next
page.)
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Control

✐ Loading the Set  ✐
Click the pull-down menu of Load Setting No. and select the set number you wish to load.
Click Set button to display the value of the set.

2. Select Set Number and name the setting
Select the Set Number you wish to store the adjustment from the pull-down menu.
Enter the name of the setting in the Memo field.

3. Save the setting (Set)
Click Save button to save the adjustment.

Enter the name of the setting

Select the set number from
the pull-down menu.
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Menu

On this screen, you can control the projector menu via network. Click ON of Display Menu item
to show the projector menu. Use cursor buttons to control the pointer.

Parameter Description

Display Menu ....Click ON to display the projector menu.
Click OFF to cancel it.

Cursor ................Click 7 8 ed to move the pointer.
Click Set button to execute the
selected item.
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11. Network Viewer
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If you use Network Viewer function, you can
display the image data stored in the FTP server
from the projector.
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11. Network Viewer

Network Viewer is used to display the image data stored in a FTP server via wireless or wired
LAN. The signal flow between the FTP server, MCI and the MCI Client computer (Computer
installed with MCI Client) is as below:

About Network Viewer

■ Wireless LAN Infrastructure Mode

■ Wireless LAN AdHoc Mode

MCI Client
Computer

Access Point

FTP Server

Image data

MCI（Wireless LAN card）
Infrastructure Mode

Wireless LAN compatible computer
Infrastructure Mode

MCI Client Computer
AdHoc Mode

FTP Server
Computer

AdHoc Mode

Image data

MCI（Wireless LAN card）
AdHoc Mode

Server direction

Server direction

Server direction

Server direction
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Overview

■ Wired LAN Mode

Operation

Displaying the image in the FTP server is executed as following procedures:

1. First the MCI Client send information of the FTP server which provides image data to the
MCI where the information is stored.

2. The MCI Client transmits an instruction to display image data to the MCI. Then the MCI
access to the FTP server to load and display the image data following the instruction. 

System Requirements for The FTP Server

Operation System ......WindowsNT4.0, Windows2000 Professional, or Windows XP
Professional has access to the FTP service.

Account ........................Should have an account with full access authority or have permission to
anonymous accounts.

MCI Client
Computer

Server direction

Image dataFTP Server

MCI（Wired LAN card）
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Displaying Image in the FTP Server

Network Viewer can be operated by 1. PJ Controller, 2. Browser, and 3. Projector.
If you operate the Network Viewer from the projector, you have to complete the configuration
of the FTP server by using PJ Controller or Web Browser in advance. 

Operation from PJ Controller

1. Select input source of the projector (Wired/Wireless)
Select "Wireless" for Wireless LAN and "Wired" for Wired LAN for the input source of the
projector. Start up the MCI Client. 
Detected projector names and IP addresses will be displayed.

2. Specify the projector to display the
image
Only one projector can be selected.

3. Start up PJ Controller
Click the PJ Controller button too show the PJ Controller screen. Select a language and
Model Code at Initial Settings from the main menu.

PJ Controller 
button

4. Select Network Viewer
Select Network Viewer from the Main Menu. Operation window (next page) will be
displayed.

Initial Settings Network Viewer

Main Menu

Select a
projector

Caution: Model Code of your projector is shown in the field of Optional Parts list of the owner's manual.
Select the correct code. Should the code be wrong, the projector may not work properly.
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Displaying Image in the FTP Server

5. Specify the FTP server to provide image data
Host Name.... Input IP address of the server.
Folder Path.... Specify the directory where image data is stored. When the image data is in

the root directory, just "/" is displayed. When the image data is in a specified
directory, put slashes"/" between directories such as /test/data etc. 

User ID ..........Input login ID access to the server.*
Password ......Input login password access to the server.*

* If the account is anonymous, put "anonymous" in "User ID " field and and appropriate 
ASCII code in "Password" field.  

6. Click Set button
Click Set button to set up the server information on the specified projector (MCI).
The configured server information can be stored even if you unplug the projector .

7. Select Play Mode and display the image
Play Mode ............Auto (Infinite Loop) (Keeps playing images repeatedly)

Auto (Plays or pauses all the images according to the Auto Play Setting mode)
Manual (Plays images manually)

Auto Play Setting...Sec. (Sets time of playing back a image) 
Times (Select number of times of play back images)

Start.......................Starts play back images.
Stop ......................Stops play back images.
Pause ....................Suspends play back images in Auto Play mode.
Return ..................Returns to the previous page manually in Manual mode
Next ......................Go to next page manually in Manual mode.
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Operation from WEB Browser

1. Select input source of the projector (Wired/Wireless)
Select "Wireless" for Wireless LAN and "Wired" for Wired LAN for the input source of the
projector. Start up the MCI Client.
Detected projector names and IP addresses will be displayed.

2. Specify the projector to display the image
Only one projector can be selected.

3. Click "Configure Multi Card Imager device" button (See page 39)
Web browser starts up and the MCI Configuration screen will appear.
Select Network Viewer from the MENU.
Configuration screen for Network Viewer (next page) will appear.
Note: MCI Configuration screen can be also displayed by entering the IP address directly on the

browser's URL.  (eg. http://00.00.00.00)

4. Specify the FTP server to provide image data
Host Name.... ..........Input IP address of the server.
Folder Path.... ..........Specify the directory where image data is stored. When the image data

is in the root directory, just "/" is displayed. When the image data is in a
specified directory, put slashes"/" between directories such as /test/data
etc. 

User ID ....................Input login ID access to the server.*
Password ................Input login password access to the server.*

*If the account is anonymous, put "anonymous" in "User ID " field and and
appropriate ASCII code in "Password" field.  

MCI Configuration Screen

Network Viewer
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Displaying Image in the FTP Server

5. Click APPLY button
Click APPLY button to set up the server information on the specified projector(MCI).
The configured server information can be stored even if you unplug the projector .

6. Select Play Mode and display the image
Play Mode ............Auto (Infinite Loop) (Keeps playing images repeatedly)

Auto (Plays or pauses all the images according to the Auto Play Setting mode)
Manual (Plays images manually)

Auto Play Setting...Sec. (Sets time of playing back a image) 
Times (Select number of times of play back images)

Start.......................Starts play back images.
Stop ......................Stops play back images.
Pause ....................Suspends play back images in Auto Play mode.
Return ..................Returns to the previous page manually in Manual mode.
Next ......................Go to next page manually in Manual mode.
REFRESH ..............Cancel the configured values.
RESTORE Factory Default Settings
................................Restores the factory default settings of Network Viewer.

(All the values will return to the factory default settings.)
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Operation from the projector

1. Configure the FTP server.
Configure the FTP server which provides image data, referring to "Operation from PJ
Controller" or "Operation from Web browser".

To operate the Network Viewer from the projector, the FTP server needs to be configured by PJ
Controller or web browser in advance.
Regarding the configuration of the FTP server, refer to "Operation from PJ Controller" or
"Operation from Web browser".

2. Select input source of the projector (Wired/Wireless)
Select "Wireless" for Wireless LAN and "Wired" for Wired LAN for the input source of the
projector.

3. Select Wireless Viewer or Wired Viewer from the MCI menu
Select "Wireless Viewer" when using wireless LAN or "Wired Viewer" when using wired LAN
from the MCI menu of the projector. Viewer Setting screen will appear.(See the next page)

4. Select Play Mode and execute the operation
Move the red arrow pointer to the item you wish to choose.
Using Point buttons and SELECT button of the projector, configure or execute each item.

Auto ........................Plays images and stop playing according to following configurations.
Second ....................Sets timing to switch images in Auto play mode. (3-240 sec.)

∽ ............................Setting "On" makes the projector keep playing images repeatedly.
Times ......................Specifies the  number of repeating times of auto play. (Maximum 255

times)
Manual ....................Switches images manually.

Press Point Up button on the projector (or the remote control) to show
next image and Point Down button to show the previous image.
Connect

Connect to the FTP server

..........................Move the red arrow pointer to "Connect" and press SELECT button on
the projector (or the remote control) to connect the MCI to the FTP
server. Then the projector starts playing the images in the FTP server.

Disconnect from the FTP server

..........................Move the red arrow pointer to "Disconnect" and press SELECT button
on the projector (or the remote control) to disconnect the MCI from the
FTP server. 
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Displaying Image in the FTP Server

Wired LAN

Caution:
Do not remove the MCI from the projector or turn off the projector while the projector is playing
images. Disconnect the MCI from the FTP server before removing the MCI from the projector.
Removing the MCI while it is operating may lock the projector. If this happens, turn off and
unplug the projector.

Pointer

Wired Viewer

Check mark

Wireless LAN

Wireless Viewer
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12. Appendix

If you have any trouble in setup or operation of the MCI, refer to the troubleshooting below and
check the relevant matters described.

Troubleshooting

■ MCI Client computer cannot detect projectors.
Make sure that Wireless or Wired is selected from the input source menu of the projector.
Does the message "Waiting For Connection" appear on screen?

No ........The MCI is not attached to the projector properly. 
Check the following matters:

*Is the POWER indicator of the MCI lighting?
*Is the indicator of the wired/wireless LAN card lighting?

->Check if the LAN card is inserted correctly into the MCI.
*Is the LAN cable connected to the wired LAN card properly? 
->Check the setting on 4. Installation, 6. Wired LAN Configuration or 7.

Wireless LAN Configuration.
Yes ......LAN setting is not correct. Check the following matters.

■ Connection between PC and the projector via wireless LAN cannot be established.

AdHoc Mode:

When selecting LAN3(factory default setting)

Check each item in the Wireless Setting menu of the projector as follows:
*IP Address ..........Is the address appropriate? Should not be same as the other IP

address.
*Sub net ................Should be the factory default value, 255.255.255.0. 
*Gateway ..............Should be the factory default value, 255.255.255.255
*Connection Status....Should be Ad-Hoc mode
*ESSID/SSID/IBSSID
..................................Should be same as the setting  of the MCI Client

->Check the setting for the MCI Client
*Is the wireless channel set as 11?

->The factory default channel of the MCI is 11.
*ESSID/SSID/IBSSID should be same as the projector.
*WEP (Wired Equivalent Privacy)
..................................Should be disabled. 

->To enable the function, set WEP at the web browser after the 
connection is established. (Refer to 8. Configuration with Browser)
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Infrastructure Mode:

When selecting LAN2 (factory default setting)

Check each item of the Wireless Setting menu of the projector as follows:
*IP Address ..................No setting is required.
*Sub net ......................Should be same as the setting of the access point
*Gateway......................Should be same as the setting of the access point
*Connection Status ......Should be Infrastructure mode
*ESSID/SSID/IBSSID....Should be same as the setting of the access point

Check the settings for MCI Client computer
*IP Address ..................No setting is required.
*Wireless Channel........Should be 11
*ESSID/SSID/IBSSID....Is same as the setting of the access point? 
*WEP............................Should be disabled.

->To enable the function, set WEP at the web browser after the 
connection is established.(Refer to 8. Configuration with Browser)

* When using LAN2, it is necessary DHCP/BOOT server is under environment enables those servers
communicate via network. Some access points may have DHCP function. For detail of the settings,
refer to the owner's manual for the devices or consult a system administrator of the network.

Is the segment where the projector is installed different from the MCI?
Specify IP Adress directly on the optional setting. Refer to "7. Wireless LAN Configuration", p39.

■ Connection between PC and the projector via wired LAN cannot be established.

When selecting LAN4 (factory default setting)

Check IP address, Sub net and Gateway of the projector and MCI.For further details of the

configuration, contact your system administrator.

Is the segment where the projector is installed different from the MCI?
Specify IP Adress directly on the optional setting. Refer to 7. Wireless LAN Configuration, p39.

About Settings for LAN Environment:

If you set the MCI under existed LAN environment, connect MCI Client computer to the MCI
in accordance with the factory default settings.  Make detailed settings by the web browser
and then restore the environment of the MCI Client computer.
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■ Cannot start up Web Browser

Is connection between PC and the projector by using MCI Client established?
No........Check settings for Wireless/Wired LAN.
Yes ......Check settings of the proxy server at browser. Refer to "8. Configuration with

Browser" (P 41)

■ Although connection between PC and the projector is established by using

MCI Client, images are not projected on screen.
Make sure Wireless/ Wired is selected from the Input source menu of the projector.

■ Trying to use PJ Controller but correct operation window does not appear or

actual operation windows displayed are different from those on the owner's

manual.
Input correct model code at the initial setting for PJ Controller.
Refer to p64 in "10. PJ Controller".
Caution: Explanations about the operation and images contained in the owner's manual may differ from

actual ones as they are based on standard models.  Read the owner's manual of the projector to
be used with the MCI before operation.

■ The projector cannot be turned on/off by operation with PJ Controller.
Make sure the settings of the projector are correct to use the MCI with it.
Refer to " Power and Status" in "10. PJ Controller".

■ Network Viewer does not work by the operation of the projector.
Make sure the settings of the FTP server are correct. You should set up the FTP server
before using Network Viewer. Refer to 11.Network Viewer.

■ Speed of playing back images are very slow.

When connecting on ad-hoc mode,  check which wireless channel you are using.
If PC using the same channel as yours is existing closely, the networking speed may be
diminished or the communication unstable. Change channel to resolve the problem. The
channels of the MCI and MCI Client computer must be the same. Or adjust the compression
format at the optional setting from the PJ Controller menu.
Refer to "9. Display Image via Network".

■ MCI Client and the MCI are suspended and  do not restart

Close the MCI Client application, turn off and unplug the projector. And then turn of the
projector again.
Caution: Do not remove the MCI from the projector while the Network Viewer is working.

It may lock MCI Client and the MCI leading to malfunction of them.
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DHCP server (Dynamic Host Configuration Protocol)
It is necessary to set an IP address for each computer or equivalent equipment when establishing a
network by TCP/IP. If there exist DHCP server on the network, it will assign IP addresses to client
computers every time they request it.  If there exist equipment with DHCP server functions (such as a
Windows 2000 server and a dial-up router)on the network, the DHCP server function may be automatically
operating.  Ask your system administrator whether the DHCP server is operating. 

ESSID (Extended Service Set Identifier)
ESSID is the ID that is set to computers on wireless LAN or access point in order to prevent each
computer from being crossed.  The computers or access point to which the same ESSID is set can
communicate with each other.  If an ESSID is different, it is impossible to communicate.  ESSID
distinguishes between lowercase and uppercase characters, and allows you to use English one byte
characters and half-size symbols up to 32 characters.

WEP (Wired Equivalent Privacy)
WEP is a security protocol for wireless LAN.  It protects computers on wireless LAN and access point from
unauthorized access by setting a description code onto them.  It is necessary to set the same decryption
code for equipment. 

Wi-Fi (the Standard for Wireless Fidelity)
Wi-Fi is short for wireless fidelity and a marketing brand name for IEEE 802.11b High-Rate. Only the
products that have passed an inter-operation test carried by WECA is approved as Wi-Fi.  Any products
approved as Wi-Fi are certified as interoperable with each other by WECA.  It is recommended to use the
products approved by Wi-Fi when introducing network equipment such as local area network. 

Wireless Channel
It is necessary to divide frequency spectrums into some wireless channels for wireless communication,
and to tune to the same channel between wireless equipment.  If you use the same channel on the same
floor, and there are some wireless LANs that have a different ESSID for each, the communication speed
may become slow.  In this case, using different channels for each wireless LAN is effective, and lowers a
possibility of mutual interference between wireless LANs

WECA (Wireless Ethernet Compatibility Alliance)
WECA is an organization promoting IEEE802.11b High -Range standard and assuring the compatibility of
products that meet the standard.

MAC address (Media Access Control Address)
MAC address is a physical address for every network interface.  The MAC address consists of 6-byte hex
number. The first 3 bytes are a Vendor ID controlled and assigned by IEEE. .  The last 3 bytes are controlled
and assigned by the manufacturers of network interface. (no duplication of MAC address)  Therefore, MAC
address is a unique physical address in the world.  Ethernet sends and receives frames on the basis of
MAC address.

Terminology

Troubleshooting

Terminology
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Setting up the IP address with “arp” + “ping”command 

In addition to using MCI Client in the supplied CD-ROM, you can use “arp” and “ping”
command from Command Prompt to assign an IP address to your MCI.

1.Start up MCI and configure the wireless LAN card in your PC to communicate with the
MCI unit.

2.From Windows [Start] menu, click [Run].  In the field next to [Open:], enter “command”
and click [OK].  When “MS-DOS prompt” (or command prompt) appears, type in “arp”
command as follows:

(Example)
C:\ > arp  -s  169.254.1.100  00-c0-6f-05-1c-c2 

Indicates an IP address you wish to assign to your MCI.
Separates MAC address of your MCI unit every two characters by hyphen.
MAC address is indicated on a label attached to the bottom of each unit.

3.Next, enter “ping” command as follows:
(Example)
C:\ > ping  169.254.1.100 (by executing ping command, the IP address will be set)

Indicates an IP address you wish to assign to your MCI.

Reply from 169.254.1.100:bytes=32 times=2ms TTL=255
(if this message appears, the IP address was successfully assigned to MCI)

Note: The assigned IP address is saved in the firmware of MCI, thus it will remain set even when

the power is off.  You can use the same method to re-assign an IP address.

If [arp+ping] option is disabled in TCP/IP setting of the MCI, you cannot assign an IP address

using “arp” and “ping” commands. (In factory default state, [arp+ping] is set to “Enable”).
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Multi Card Director 

Specifications

Power
Power Consumption Operating：DC3.3V 1.5A(MAX)

Standby :DC3.3V 1.2A(MAX)
Projector Interface

External Interface Digital RGB output :DVI 29pin（male）
Environment

Operating Temperature 5～35℃
Storage temperature -20～60℃

Certification
Japan VCCI ClassB

TELEC
USA FCC Class B
Canada IC(ICES-003 )
Europe CE Mark

Other
Dimentions 129(W)×70(D)×27(H) mm
weight 170g

Wireless LAN Card

Network Standard IEEE802.11b
Network Type 802.11 AdHoc、Infrustracture
Frequency band 2,412MHz - 2,462MHz (Channels 1-11)

In France: 2,457MHz-2,462MHz (Channels: 10-11)
Modulation CCK、BPSK、QPSK
Communication Range Outdoor 120m / Indoor 80m

*Above data may vary depending on the operating environment
Data Transter Rate 1/2/5.5/11Mbps（Auto-sensing, Auto-switching）
Security WEP40/128bit、SSID/ESSID
Protocol TCP/IP
Dimentions 43(W) ×57(D) × 10(H) mm
Weight 20g

Wired LAN Card

Data Transter Rate 10Mbps (10BASE-T)
Protocol TCP / IP
Dimentions 43(W) ×88(D) × 15(H) mm
Weight 30g
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